Chapter 542

GEE Tests for Two Proportions in a Split-Mouth Design

Introduction

This procedure assumes that binary data will be obtained from a study that uses a split-mouth design. The GEE method is used to analyze the repeated measures model that is assumed. The sample size formula is derived in Zhu, Zhang, and Ahn (2017).

A split-mouth design is used in dental trials in which treatments are randomized over segments of the mouth within each subject. In this design, the mouth is divided into two or more segments or regions. For example, the segments might be top and bottom, left and right, or a combination of both. Within each segment, specific sites (e.g. teeth) are identified. The same treatment is applied to all sites within a segment.

The split-mouth design, also called the split-cluster design, is occasionally used in other areas such as dermatology and animal studies. Although the design may be used in other experiments, the terminology of the split-mouth design will be used in this procedure.

Technical Details

Our formulation comes from Zhu, Zhang, and Ahn (2017). The goal of this analysis will be to provide a test comparing the response proportions of two groups. We assume that the two groups are labelled “1” for treatment and “2” for control.

Denote an observation by \( Y_{ijk} \) where \( i = 1, 2 \) gives the group, \( j = 1, 2, \ldots, N \) gives the subject, and \( k = 1, 2, \ldots, M \) gives the site. A “success” is represented by \( Y_{ijk} = 1 \) and a “failure” by \( Y_{ijk} = 0 \). Note that the segments themselves are not specified directly in the model. Also note that the total number of sites per subject is \( 2M \).

The following logistic regression model will be analyzed using GEE.

\[
\text{logit}\{\Pr(Y_{ijk} = 1)\} = \log \left( \frac{p_{ijk}}{1 - p_{ijk}} \right) = \beta_0 + \beta_1 x_{ij} + \epsilon_{ijk}
\]

where \( Y_{ijk} \) follows a Bernoulli distribution with parameter \( p_{ijk} \), \( \beta_0 \) is the log-transformed odds for group 2 (control group), \( \beta_1 \) is the log-transformed odds ratio between the treatment and control groups, \( x_{ij} = 1 \) if the site is in group 1 and \( x_{ij} = 0 \) if the site is in group 2, and \( \epsilon_{ijk} \) is random error.

Two alternative models are available to model the correlation between \( Y_{ijk} \) and \( Y_{ij'k'} \) (responses within the same subject). The simpler model assumes that a common, within-subject, correlation \( \rho \) is at work. A more general model assumes that there are two, within-subject, correlations. These are \( \rho_W \), which is the correlation between
responses of sites within the same segment, and \( \rho_B \), which is the correlation between responses of sites that are not in the same segment.

Zhu, Zhang, and Ahn (2017) provide formulas for the overall sample size for a two-sided test as follows

\[
N = \frac{\sigma^2 \left( z_{1-\alpha} + z_{1-\beta} \right)^2}{\beta_1^2}
\]

where

\[
\sigma^2 = \frac{1 + (M - 1)\rho_W(P_1 Q_1 + P_2 Q_2) - 2M\rho_B\sqrt{P_1 Q_1 P_2 Q_2}}{MP_1 Q_1 P_2 Q_2}
\]

\[
P_1 = \frac{\exp(\beta_0 + \beta_1)}{1 + \exp(\beta_0 + \beta_1)}
\]

\[
P_2 = \frac{\exp(\beta_0)}{1 + \exp(\beta_0)}
\]

\[
Q_1 = 1 - P_1
\]

\[
Q_2 = 1 - P_2
\]

\[
\beta_1 = \log \left( \frac{P_1/Q_1}{P_2/Q_2} \right)
\]

and \( \alpha \) is the probability of a type-I error and \( \beta \) is the probability of a type-II error.

\( P_1 \) and \( P_2 \) are the true success rates of groups 1 (treatment) and 2 (control). These are the values assumed by the alternative hypothesis at which the power is calculated.

These results are for the general two, within-subject correlations. The sample size for the one correlation method is obtained by setting \( \rho = \rho_W = \rho_B \).

### Procedure Options

This section describes the options that are specific to this procedure. These are located on the Design tab. For more information about the options of other tabs, go to the Procedure Window chapter.

### Design Tab

The Design tab contains most of the parameters and options that you will be concerned with.

#### Solve For

This option specifies the parameter to be solved for from the other parameters. The parameters that may be selected are Power, Sample Size, or Effect Size.

Note that the value selected here always appears as the vertical axis on the charts.

The program is set up to calculate power directly. To find appropriate values of the other parameters, a binary search is made using an iterative procedure until an appropriate value is found.
Power and Alpha

Power
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null hypothesis is not rejected.

Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now, 0.90 (Beta = 0.10) is also commonly used.

A single value may be entered or a range of values such as 0.8 to 0.95 by 0.05 may be entered.

If your only interest is in determining the appropriate sample size for a confidence interval, set power to 0.5.

Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true null hypothesis is rejected.

Note that this procedure assumes a two-sided test.

Values must be between zero and one. Usually, the value of 0.05 is used for alpha and this has become a standard. This means that about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that represents the risk of a type-I error you are willing to take in your experimental situation.

You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.

Sample Size

N (Subjects)
Enter one or more values for N, the number of subjects in the study. If you enter a list of values, a separate analysis is done for each value.

Range
N > 1
Examples: 10 20 30 40 or 20 to 200 by 20.

M (Sites Per Group Per Subject)
Enter one or more values of the number of sites (e.g. teeth) per group per subject. The design is balanced so that M is the number of sites in all segments assigned to the treatment group and also M is the number of sites in all segments assigned to the control group.

The split-mouth design assumes that the mouth is subdivided into two or more segments (e.g. left and right, top and bottom, etc.), each made up of a number of sites. The two treatments are randomly assigned to segments in such a way that both groups include M sites.

Range
This value must be a positive integer that is at least 2.

List
You can use a list of values such as "4 6 8". A separate analysis will be run for each element in the list.
**Effect Size**

**P1 Input Type**
Indicate what type of values to enter to specify P1, the group 1 event probability. Regardless of the entry type chosen, the same test statistic is used in the power and sample size calculations. This option is simply given for convenience in specifying the P1.

The choices are

- **P1**
  Enter values for P1 directly.

- **Difference (P1 - P2)**
  Enter values for the difference (P1 - P2) and values for P2. The corresponding value of P1 will be computed from these two values.

- **Ratio (P1 / P2)**
  Enter values for the ratio (P1 / P2) and values for P2. The corresponding value of P1 will be computed from these two values.

- **Odds Ratio (O1 / O2)**
  Enter values for the odds ratio (O1 / O2) and values for P2. The corresponding value of P1 will be computed from these two values.
  Note that O1 = P1/(1-P1) and O2 = P2/(1-P2)

**P1 (Group 1 Proportion)**
Enter a value for the response proportion of group 1 (the experimental or treatment group) under the alternative hypothesis, H1. The power calculations assume that this is the actual value of the proportion.

Values must be between 0 and 1. This value must be different from P2.

You can enter a single value such as 0.1 or a series of values such as 0.1 0.2 0.3 or 0.1 to 0.5 by 0.1.

**P2 (Group 2 Proportion)**
Enter a value for the response proportion of group 2 (the control, baseline, standard, or reference group).

Values must be between 0 and 1. This value must be different from P1.

You can enter a single value such as 0.1 or a series of values such as 0.1 0.2 0.3 or 0.1 to 0.5 by 0.1.

**Difference (P1 - P2)**
Enter the difference between P1 and P2. This difference is used with P2 to calculate the value of P1 using the formula: P1 = Diff+ P2.

You can enter a single value such as 0.05 or a series of values such as 0.03 0.05 0.10 or 0.01 to 0.09 by 0.02.

**Range**
Differences must be between -1 and 1. They cannot take on the values -1, 0, or 1. The resulting value of P1 must be between 0 and 1. If it is not, the scenario is skipped.
Ratio (P1 / P2)
Enter the ratio of the two probabilities P1 and P2. This ratio is used with P2 to calculate the value of P1 using the formula: \( P1 = \text{Ratio} \times P2 \).
You can enter a single value such as 0.5 or a series of values such as 0.5 0.6 0.7 0.8 or 0.25 to 2.0 by 0.25.

Range
Ratios must be greater than zero. They cannot take on the value of one. The resulting value of P1 must be between 0 and 1. If it is not, it is changed so that it is between 0 and 1.

Odds Ratio (O1 / O2)
This option specifies the odds ratio between the two probabilities P1 and P2. This value is used with P2 to calculate the value of P1.
You can enter a single value such as 0.5 or a series of values such as 0.5 0.6 0.7 0.8 or 1.25 to 2.0 by 0.25.

Range
Odds ratios must be greater than zero. They cannot take on the value of one.

Correlation Matrix Structure
Specify the structure of the correlation matrix of sites within a subject. The possible choices are

- **One Within-Subject Correlation (ρ)**
  A common correlation is assumed for all outcome pairs within the same subject.

- **Two Within-Subject Correlations (ρbw, ρw)**
  Two within-subject correlations are needed:
  - ρbw is the correlation between sites in different segments within a subject.
  - ρw is the correlation between sites within a particular segment within a subject.

ρ (Within-Subject Correlation)
Enter one or more values for ρ, the common correlation of site outcomes within the same subject. At least one value must be entered. If multiple values are entered, a separate analysis is performed for each value.

Range
\(-1 < ρ < 1\). A value near 0 indicates low correlation. A value near 1 indicates high correlation.

Note that negative values may cause numerical trouble and should be avoided.
You can enter a single value such as 0.5 or a series of values such as 0.5 0.6 0.7 or 0 to 0.8 by 0.1.

ρbw (Between-Segment Correlation)
Enter one or more values for ρbw, the correlation of site outcomes that are in different segments within a subject. At least one value must be entered. If multiple values are entered, a separate analysis is performed for each value.

Range
\(-1 < ρ < 1\). A value near 0 indicates low correlation. A value near 1 indicates high correlation.

Note that negative values may cause numerical trouble and should be avoided.
You can enter a single value such as 0.5 or a series of values such as 0.5 0.6 0.7 or 0 to 0.8 by 0.1.
**ρw (Within-Segment Correlation)**

Enter one or more values for ρw, the correlation of site outcomes that are in the same segments within a subject. At least one value must be entered. If multiple values are entered, a separate analysis is performed for each value.

**Range**
-1 < ρ < 1. A value near 0 indicates low correlation. A value near 1 indicates high correlation.

Note that negative values may cause numerical trouble and should be avoided.

You can enter a single value such as 0.5 or a series of values such as 0.5 0.6 0.7 or 0 to 0.8 by 0.1.
Example 1 – Calculating Sample Size

Suppose a dental clinical trial is being planned in which the mouth is divided into four segments with three sites in each. The trial is being conducted to compare a new treatment for gingivitis with a common existing treatment. In the study, suppose \( P1 = 0.6, 0.65, 0.7; P2 = 0.5; \rho_b = 0.2, 0.4, 0.6, 0.8; \rho_w = 0.8; M = 5; \alpha = 0.05; \) and \( \text{power} = 0.9 \). Sample size is to be calculated for a two-sided test.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the procedure window. You may then make the appropriate entries as listed below, or open Example 1 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Sample Size</td>
</tr>
<tr>
<td>Power</td>
<td>0.90</td>
</tr>
<tr>
<td>Alpha (Two-Sided Test)</td>
<td>0.05</td>
</tr>
<tr>
<td>M (Sites Per Group Per Subject)</td>
<td>5</td>
</tr>
<tr>
<td>P1 Input Type</td>
<td>P1</td>
</tr>
<tr>
<td>P1 (Group 1 Proportion)</td>
<td>0.6 0.65 0.7</td>
</tr>
<tr>
<td>P2 (Group 2 Proportion)</td>
<td>0.5</td>
</tr>
<tr>
<td>Correlation Matrix Structure</td>
<td>Two Within-Subject Correlations (( \rho_b, \rho_w ))</td>
</tr>
<tr>
<td>( \rho_b ) (Between-Segment Correlation)</td>
<td>0.2 0.4 0.6 0.8</td>
</tr>
<tr>
<td>( \rho_w ) (Within-Segment Correlation)</td>
<td>0.8</td>
</tr>
</tbody>
</table>

Annotated Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

<table>
<thead>
<tr>
<th>Power</th>
<th>Total Sample Size N</th>
<th>Sites Per Group Per Subject</th>
<th>Sites Per Subject</th>
<th>Between Segment Corr ( \rho_b )</th>
<th>Within Segment Corr ( \rho_w )</th>
<th>Alpha</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.9008</td>
<td>335</td>
<td>5</td>
<td>P1 0.6000</td>
<td>P2 0.5000</td>
<td>P1-P2 Corr Diff 0.1000</td>
<td>0.2000</td>
</tr>
<tr>
<td>0.9004</td>
<td>230</td>
<td>5</td>
<td>P1 0.6000</td>
<td>P2 0.5000</td>
<td>P1-P2 Corr Diff 0.1000</td>
<td>0.4000</td>
</tr>
<tr>
<td>0.9015</td>
<td>126</td>
<td>5</td>
<td>P1 0.6000</td>
<td>P2 0.5000</td>
<td>P1-P2 Corr Diff 0.1000</td>
<td>0.6000</td>
</tr>
<tr>
<td>0.9005</td>
<td>21</td>
<td>5</td>
<td>P1 0.6000</td>
<td>P2 0.5000</td>
<td>P1-P2 Corr Diff 0.1000</td>
<td>0.8000</td>
</tr>
<tr>
<td>0.9012</td>
<td>148</td>
<td>5</td>
<td>P1 0.6500</td>
<td>P2 0.5000</td>
<td>P1-P2 Corr Diff 0.1500</td>
<td>0.2000</td>
</tr>
<tr>
<td>0.9017</td>
<td>102</td>
<td>5</td>
<td>P1 0.6500</td>
<td>P2 0.5000</td>
<td>P1-P2 Corr Diff 0.1500</td>
<td>0.4000</td>
</tr>
<tr>
<td>0.9030</td>
<td>56</td>
<td>5</td>
<td>P1 0.6500</td>
<td>P2 0.5000</td>
<td>P1-P2 Corr Diff 0.1500</td>
<td>0.6000</td>
</tr>
<tr>
<td>0.9164</td>
<td>10</td>
<td>5</td>
<td>P1 0.6500</td>
<td>P2 0.5000</td>
<td>P1-P2 Corr Diff 0.1500</td>
<td>0.8000</td>
</tr>
<tr>
<td>0.9028</td>
<td>83</td>
<td>5</td>
<td>P1 0.7000</td>
<td>P2 0.5000</td>
<td>P1-P2 Corr Diff 0.2000</td>
<td>0.2000</td>
</tr>
<tr>
<td>0.9019</td>
<td>57</td>
<td>5</td>
<td>P1 0.7000</td>
<td>P2 0.5000</td>
<td>P1-P2 Corr Diff 0.2000</td>
<td>0.4000</td>
</tr>
<tr>
<td>0.9082</td>
<td>32</td>
<td>5</td>
<td>P1 0.7000</td>
<td>P2 0.5000</td>
<td>P1-P2 Corr Diff 0.2000</td>
<td>0.6000</td>
</tr>
<tr>
<td>0.9222</td>
<td>6</td>
<td>5</td>
<td>P1 0.7000</td>
<td>P2 0.5000</td>
<td>P1-P2 Corr Diff 0.2000</td>
<td>0.8000</td>
</tr>
</tbody>
</table>

References

Report Definitions
Power is the probability of rejecting a false null hypothesis.
Total Sample Size N is the total number of subjects in the study.
Sites Per Group Per Subject M is the number of sites per subject in the treatment group and the control group.
P1 is the proportion of "true" responses in group 1 (treatment group).
P2 is the proportion of "true" responses in group 2 (control group).
Between Segment Corr $\rho_b$ is the correlation between sites in different segments within a subject.
Within Segment Corr $\rho_w$ is the correlation between sites within a segment within a subject.
Alpha is the significance level of the test: the probability of rejecting the null hypothesis of equal means when it is true.

Summary Statements
A split-mouth (split-cluster) design is used to test the difference between two response proportions. The logistic regression model will be analyzed using GEE. A sample of 335 subjects with 5 sites per group per subject achieves 90% power at a significance level of 0.050 to detect a difference of 0.1000. The response proportion of group 1 is 0.6000 and of group 2 is 0.5000. The correlation matrix is formed using a correlation of 0.8000 for sites within the same segment and a correlation of 0.2000 for sites from different segments.

This report gives the sample size for each of the scenarios.

Plots Section

These plots show the sample size for the various combination of the other parameters.

Zhu, Zhang, and Ahn (2017) page 2549 provide a table (Table 2) in which several sample size values are presented. We will use the first entry from this table to validate this procedure.

In the first row of Table 2, $P_1 = 0.15$; $P_2 = 0.1$; $\rho_v = 0.05$; $\rho_w = 0.1$; $M = 3$; alpha $= 0.05$; and power $= 0.8$. The resulting $N$ is 244.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the procedure window. You may then make the appropriate entries as listed below, or open Example 2 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Sample Size</td>
</tr>
<tr>
<td>Power</td>
<td>0.8</td>
</tr>
<tr>
<td>Alpha (Two-Sided Test)</td>
<td>0.05</td>
</tr>
<tr>
<td>$M$ (Sites Per Group Per Subject)</td>
<td>3</td>
</tr>
<tr>
<td>$P_1$ Input Type</td>
<td>$P_1$</td>
</tr>
<tr>
<td>$P_1$ (Group 1 Proportion)</td>
<td>0.15</td>
</tr>
<tr>
<td>$P_2$ (Group 2 Proportion)</td>
<td>0.1</td>
</tr>
<tr>
<td>Correlation Matrix Structure</td>
<td>Two Within-Subject Correlations ($\rho_v$, $\rho_w$)</td>
</tr>
<tr>
<td>$\rho_v$ (Between-Segment Correlation)</td>
<td>0.05</td>
</tr>
<tr>
<td>$\rho_w$ (Within-Segment Correlation)</td>
<td>0.1</td>
</tr>
</tbody>
</table>

Output

Click the Calculate button to perform the calculations and generate the following output.

PASS matches the sample size of 244.